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Civil 2023 (v1.1) Release Note

Civil 2023

1. =B E R FREBEFASCICULE N° 61 TITRE 1B ENSHE 517

- BENERERTIE AR ERRRE -
- FEBEM : Fascicule N° 61, Conception, Calcul et Epreuves des Ouvrages d'art, Titre Il - Programmes de Charges et Epreuves des Ponts-Routes

= Load> Moving Load > Moving Load Code > France

| Define Standard Vehicular Load * | Define Standard Vehicular Load X | Define Standard Vehicular Load X
Standard Name Standard Mame Standard Name
Load System A ~ | i Y] | Military Load HY
! Vehicular Load Properties | | Vehicular Load Properties | Vehicular Load Properties
Vehicular Load Name : Load System A Vehicular Load Name : Load System Bc Vehicular Load Name : System Mc 80
Vehicular Load Type : Load System A ~ Vehicular Load Type : Load System Bc Vehicular Load Type : System Mc 80 ~
Pz Pz Pz Pz
A= ai 3y AL P Pt Tracked
= alxa2x All) Vehicles P
1 T s f—s — f—st ¥ o4 oL
I | I Dz  =4.5m I Dz [Pty RTTTTTTS
L
D D
= 35.4m
z — ="
AlL) = 2.3 + 3680/(L+12) kN;’m- No Load{d) Spacing(m) Distance Between two Vehdes —
AL x a1l = (4-0.0020) kN/m 1 50 a5 Min = 4.5m
2 120 1.5 Max = Infinite
3 120 end
Coeffidental Min, Distance Between Two Vehides 35.4 o
MNumber of Loaded Lanes 1 2 £} 4 =5 Coefficent be P72 kM D 49 m
First Class 1 1 09| 075 07
Bridge Number of Loaded Lanes 1 2 3 4 =5 8 Apply Dynamic Factor
cl Second Class 1 0.9 = = = -
355 - First Class 12| 11| 095 08| 07
Third Class 09| 08 = = = Bridge
Cae [ SecongCiss | A Al | - Cneel oy
Lane Width Coeffidenta2 = vOjv v = Loadable Width/Mumber of Lanes Third Class 1 0.8 - - -
Nominal Width (m) vo e Military Load Mc 80
Dynamic Factor
] First Class 35 thel
%T:g: Second Class 3
Third Class 275 Cancd Anply

Load System Bc

ol el
J

Load System A
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Civil 2023 (v1.1) Release Note

1. =B E R FREBEFASCICULE N° 61 TITRE 1B ENSHE 517
- EHEREUERERR - MIFEE—FENR -

= Load> Moving Load > Moving Load Code > France

Lane Mame : Lane B

Traffic Lane Properties

2,25 4,50 1,50 |1225| 2,25 450 1,50 R25
4 )
AP N S - 5 5 5 5 0,20 0,25
T —a 60KN 120KN  [20KN 60KN 120KN  120KN| _.|_|.._ _.|_|‘_
Start End 10,50 . 10,50 . 3 % \
.. =) -
a ¢ Eccentricit o
Y Longitudinalement PR 8

2,00

© Load System (& or B)
() Military  Sidewalk / Pedestrian

Loadable Width 8.1 m

:

N\
N\
J0.50 |

Mumber of Lanes 2 _
Eccentricity a m ] =
77 T 7
0,25 2,00 ‘ 0,50 2,00 025 % %
' OO i ° . °
< > 4,50 | 1,50 |
i " N "
T |oadable Width

Figure 4.1 : Systéme B,

MibAS 4/20



Civil 2023
1. =B E R FREBEFASCICULE N° 61 TITRE 1B ENSHE 517

- I SERABEREBEES - DEIEHNEEOS.
- HEZAPEBERISAES Bc SHEINFMRE -

@ MIDAS/Text Editor - [MVmaxBcFz62_DetailResult]
@ File Edit View Window Help
Ded&ESE =L XD

Civil 2023 (v1.1) Release Note

00001 |
00002 ++ midag Civil France Moving Load Data ++

Load> Moving Load > Moving Load Code > France

Lane Mame : Lane B

Traffic Lane Properties

00003 + Moving Load Cagses @ MVmaxbc
00004+ Key Element @ B2
00005 + Components @ Fz
00008 + Maximum Value @ 5.0809e+02
00007

B @
e ] f-a
Start End
a : Eccentricity

© Load System (A or B)

() military f Sidewalk | Pedestrian
Loadable Width 8.1 m
Mumber of Lanes 2
Eccentricity 0 m

B Dynamic Factor for System B
L {(Span Length) 24 m
G (Span Weight) 2362 kM
[ centrifugal Force
Left Wheel of Vehide
0.0 W

Maoving Forward

o000
00009
b i Fact 00010 [Lanel ] |
00011
ynamic Factor 00012 + Multiple Lane Facturghcg, 1st Wehicle : 1.100
00013 + Multiple Lane Factoribc), 2nd Yehicle @ 1,100
- 00014+ Dyramic Factor for Bach dxle @ 1.241, 1.161, 1,181, 1.161, 1.161, 1.16
0.4 0,6
» » 00018
+ - 00017 [Lane2 ]
00012
I + ( ,E.JL (J 00018+ Multiple Lane Facturghc}, Ist ¥ehicle © 1.100
I + 4 I 00020+ Multiple Lane Factoribe), 2nd Yehicle @ 1,100
00021 + Dynamic Factor for Each Axle : 1.241, 1.161, 1.161, 1.161, 1.161, 1.161
'S‘ 00022 {
L
4 2
Ready tn0/21, 2
L1=24m, G1=2362kN L2 =10 m, G2 = 1520 kN
< > < >
L2 g 5
g R = == O -
r T — 1 — The T B — T — 7 — il T
i i By ——ﬁ
- —f I T g:i::::4ﬁir— I i
— = — e 1 B — Tg::jﬂﬁgg— ::TET
gﬁi Efsz iﬁa
Eccen| L G | Span Eccen.| L G | Span
MNao|Elem
m) | my | o] start | Mo Blem| = | i | gy | stant
1 82| -405| 24(2362| ¥ 40| 121| -405| 10| 930 | [
21 f2l sansl 2al93R?l T

MibAS
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Civil 2023 Civil 2023 (v1.1) Release Note

1. =B E R FREBEFASCICULE N° 61 TITRE 1B ENSHE 517
- RO EDNEEZEENETER -

= Load> Moving Load > Moving Load Code > France
* The ratio for the increase of left wheel load to consider the centrifugal forces
R+150 R < 400 80
D — | < m —_— i >
Traffic Line Lanes * 6R+350 R if R > 400m
Lane Mame : Lane B
Traffic Lane Properties - -
% ) o T3]
- — —— —— — T_a = =
Stl:art End
a = Eccentricity
© Load System (A or B) i -
() military / Sidewalk / Pedestrian c o
Loadable Width 8.1 m
Number of Lanes 2
Eccentricity 0 m |
[ | I |
("] Dynamic Factor for System B i —— i i 1= i T i i —— i
L (Span Length) 0.0 m —&E Sl i L LR
G (Span weight) 0.0 [}
B centrifugal Force
Left Wheel of Vehide 0.08
Moving Forward _—
Vertical Loads with Centrifugal Forces

mm 6/20



Civil 2023

2. French National Annex $71&Z Eurocode 2, 3, 4

Civil 2023 (v1.1) Release Note

Design> RC Design, Steel Design, Composite Design

Composite Steel Girder Design Parameters X 1
Code: EM1994-2 ~ MA: France ~
Partial Factor

Concrete(Gamma_C) P5C Design Parameters

Reinfording Steel{Gamma_5)

Design Code : -2 National Annex :
Structural Steel(Gamma_M0) . Eurocode2-2:05 >
Structural Steel(Gamma_M1) Input Parameters
Shear Resistance of a Headed Stud(c e
Moment resistance

Equivalent Constant Amplitude Stress © Consider tendons in tensie zone

Fatigue Strength(Gamma_Mf) A —

Fatigue Strength of Studs in Shear(G Strut angle

Stress in Structural Steel{Gamma_M,s 45 (Degree)

Damage equivalence factors(for Resis
Design life of the bridge in year(t_Ld) Prestressing steel type
© 5mooth bars and wires

O Indented wires

O strands
() Ribbed bars

Stress Limitation
ki: 0.6 k2:

Shear Resistance Reduction Factor of [T user input data Modify design parameters.

ks: 0.75

Qutput parameters
Ultmate Limit State Ultimate limit states serviceabilit!
mate Limi S

8 Bending Resistance [[] ultimate bending resistance [ stress

8 Resistance to Vertical Shear [Jshear resistance [Dstress

B Resistance to Lateral-torsional Bud [ Torsional resistance [princpz

8 Resistance to Transverse force [ Principz

8 Resistance to Longitudinal Shear [ Tensile
(D cradkd

8 Resistance to Fatique

(") Consider all tendons

PSC> PSC Design

France ~

Serviceability limit state
Crack control
Cement dass

Steel Design Code

Design Code : Eurocode3-2:05

National Annex : France

(] all Beams/Girders are Laterally Braced
[T Check Beam/Column Deflection

Biaxial moments for buckling resistance
© Biaxial moments at the same location

() Maximum moments along the member

(] Consider as linear summation for dass 1,2

(Eq.6.2)
Method for interaction factor, kij
0 By Code () Annex A

Point of load application for Mcr
O Top © shear Center

Prestressed Girder Design

Composite Steel Girder Desig

O Annex B

O Bottom

Close

Concrete Design Cede

Design Code : Eurocode2-2:05 ~

National Annex : France

Moment Resistance

Moment Redistribution Factor for Beam :

Column Design
10 Axial load plus biaxial bending(Fx +My-+Mz)
() Axial load plus biaxial bending{Fx+My)

(] Consider Axial-Moment Interaction for Plate Column

Shear Resistance

Strut Angle for Shear Resistance :

Terteage : .

Norme

NF EN 1992-1-1/NA
Mars 2016

P18-711-1/NA
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3. BN AR EE R FT 3R A AR

- BOM

MERLETH S ] DUERDAS L -

Civil 2023 (v1.1) Release Note

= Design> RC Design, Steel Design, Composite Design
= PSC> PSC Design
MIDAS Information Technology Co.,Ltd.
Civil 2022 (v1.1) / Vérification
= NOM DU MEMBRE : Slab-BC
1. Informations de I'élément
1) Code de conception
EN 1992-2: 2005 [ NA:France }
2) Propriéte de section
10(I1D:10)
3) Propriété matérielle
fek = 30.000MPa, f, = 500.000MPa
4) Longueur
L=0.514m
5) Données de ferraillage
Bot-Dir.1: P16@300
Top-Dir.1: P16@300
Bot-Dir.2 : P12@300
Top-Dir.2 : P13@300
2. Capacité de Moment ( Dir-x, Négatif )
Memb No. 740
Neceud No. 777
Moment Nég. LCB cLCB2
Mezd / Mad -56.696kN-m/m / -55.070kN-m/m = 0.960 oK
Prin , P, Proax Pmin = 0.00151 < p = 0.00319 < pmax = 0.04000 oK

1) Paramétre de conception

*cLCB2 :( 1.330 )SW+( 1.300 JEHmax+( 1.350 )LS+ 1.350 )MVL1+ 1.350 JEV

fek = 30.000MPa, fix = 500.000MPa
bw = 1,000.000mm, h = 260.000mm

d =210.000mm

Ast = 670.200mm*
ctee = 1.000

ye = 1.500, y= = 1.150

fed = tec fuk /e = 20.000MPa

fya = fy /ys = 434.783MPa

00 =~ & s L P =

[T RN R T R T I T I I S R i T
| AWM= O wWw o0 =@M = OO0 = @ mMmE L= O

A|B|/C|D|E|F|G|H|I

J KILMNOPQRS TUVWXY ZAABACADAEAFAG

Cislo prvku

16

Position Information

J

1.Nastaveni posudku
1.1 Navrhové paramatry

- Diléi souginitele pro mezni stav Unosnosti (EM 1992-1-1:2004, 2.4.2 4)
Navrhové situace Yo beton Y= betonafska wyztuz Y= predpjata wztuZz
Trvalé & Docasné 1.500 1.150 1.150
Mimofadné 1.200 1.000 1.000
- soucinitel des ., @ - Soutinitel pro dlouhodobé G€inky dnosnosti vtlaku a tahu.
Oge = 0.850 (pro Unosnost betonu v tlaku)
Oy = 1.000 (pro unosnost betonu v tahu)
1.2 Prifezy
b 8500.0 mm ly 7.8668E+12 mm* A 0.000 mm?
h 3000.0 mm I 2 9574E+13 mm* A 0.000 mm?®
de 0.0 mm &, 42500 mm A 0.000 mm?
ds 0.0 mm & 1790.6 mm At 0.000 mm®
A 6208720.000 mm? P 0.000 mm?
1.3 Materialy
- Beton
fae = 40.000 MPa E. = 35220.000 MPa
- Wyztuz
fe = 400.000 MPa E. = 200000.000 MPa
1.4 Predpjaté kabely
i Ploch Pevnost (MPa|
Typ Nazev kabelu Pozice Ocza : : =)
(mm) (mm=) fox fon. 1% (MPa)
1|5_A2L 500.0 2635.300 1900.000 1600.000 200000.000
2 |5_A3L 700.0 2635.300 1900.000 1600.000 200000.000
3 |S_AdR 900.0 2635.300 1900.000 1600.000 200000.000
415 _AdL 900.0 2635.300 1900.000 1600.000 200000.000

MibAS
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4. Word iR AR BRH R 85 5T ER S

- B

- PSCERETHREERRA P ZEXcelfiZzl -

MEs ol LIIWordIZ TN ES - thExcellPNER/RIER - BIBIEHLE -

Civil 2023 (v1.1) Release Note

CI
Da

Past
aste

Clipboard

Page 10f4

Arial -9 -
B I U -abex, x° & Refers | Mailir | Revie | View | Help | Design | Layout | Q Tell me O en-
- s 01 Sagging class 1 or 2940Memb [Compatibility Mode] - Word ~ Ta.. DKOIIZ @ e O
a?‘/ - - Aa- Y X A - B
A A A Arial -9 - A
cont - b . D Ry Insert Design Layout References Mailings Review View Help Design  Layout Q@ Tellme & Share
o . g Paste BT bg T X - :_ Styles  Editi Arial A
. al - =)
MIDAS Information Technology Co.,Ltd - Y - A ~Aa- A A A = - zl T - - 9-‘ ~
Civil B I U ~akx, X "
Clipboard ra Font ] Paragraph ra Styles Pa'ste - . A Aa- St{\es \.mg
= MEMBER NAME : 500x300 ( Section ID : 1, Element No.1)
MIDAS Information Technology Co.,Ltd (EIELEE = (e r‘ Beragiaply (E 58 = -~
1. Member Information
1) Besign Gade = MEMBER NAME : Column 7 W8x35 (1D : 1)
EN 1952-2: 2005 ( NAtaly )
1. Member Information - .
2) Section Property = MEMBER NAME : Steel Composite : 1-j
R 1) Design Code
500%300 (1D: 1} ? .
EN 1993-2: 2006 { N&Recommended | 1. Member Information
3) Material 1) Design Code
Concrate 2) Material EN 1994-2 [ NA - Recommended |
£, = 2500MPs, £, = 31.475MPa f, = 1.711.357MPa, £, = 189.343024MPa 2) Section Property
Reinforcement 3 Langth Comp
%, = 430MPa, f,,, = 430MPa, €, = 206,000MPa | - 2658m 3) Material
B Steel
4) Length 2 partil factors ,=345.000MPa, E: = 210,000.000MPa
! Concrete
L = 6:000m
Yoo = 1000 Vit = 1000 Vhaz = 1230 fa = 30.000MPa, Ec = 33,000.000MPa
) Reinforcement
5) Reinforcement Data .
! 5) Section Properties .= 500.000MPa, E, = 200,000.000MP2
- - - 2 4) Length
—— ——
1 o e B
5| 5 g Factor
a H v for concrete 1,500
v for reinforcing steel 1150
yoa for structural steel 1.000
I <[ v for structural steel 1100
= for headed surd 1250
vt for equivalent constant Amplitude stress range 1.000
Top 2-pad Top P24 Top a [y — Y B oocomm ywi for fatigue strength 1.000
Bottom  2-P24 Bottom  2-P24 Bottom & | oizsimm & r02izinm . 2nm v for fatigue strength of studs in shear 1000
Stimups  2-P14@200 Stimups 2-P14@200 Stirrups Way | S8 s | 173702 878t Wy | s65531 2 1men Was e &) Section Properties
" 220,458 158mant B rseiizesimm
2. Moment Capaci Ni e ) ( Sector |, 0.25L ~ g
" 2. Check Axial Resistance g8l
emb No. 1
Neg Lca Leat sodal sLeet
e Mo / M, 0.000KN-m 138k = 0000 - 287.283kN / 2.325.666kN = 0124 oK
Mome ~sicet ; swmng
0. Paw  Ous = BO0ISS < p = 0.ODGES < p,.,, = 0.04000 8
1) Check slendemess ratio of compressive member 123 -
Kl
— = 70.936 < 200000 —+ OK
848words [  English [United States) B B
— [ | Steel Section | Composite Section| Positive )} | Composite Section{ Negative ) |
Page1of9 2471words [[¥  English (United States) Ed B - L [ Area [ 34,687.500mm? | 155,867 .676mm? 43,132 020mm* | -
4 T ) T ) o ) »
Page1of 5 151Swords [[#  English (United States) [E3) B - '] + 100%

= Design> RC Design, Steel Design, Composite Design

Tut 13-D Simple 2-Bay Frame_Stl [Compatibi...

DK OJCiZ

Eal

O

MibAS
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Civil 2023

Civil 2023 (v1.1) Release Note
5. Preference :2 ERVERET RS ES

- BUMAREEEL AASHTO LRFD B9 ET3RE5Z0IH Preference BIZEE °

- AASHTO LRFD &t &S =MIEM A48 0] A Preference 21 -

= Tools> Setting > Preferences > Design/Load Code

Report Language of Preference

Preferences X
' - Environment Steel Conarete | Composite | S0D |
- General Conarels
;':g e RC PSC Rebar
Propiesty Design Code Design Code : Material Code :
|- toad Eurocode2-2:05 v Eurocode2-2:05 v ENO4(RC) v
- Results National Annex : National Annex : Material DB :
- Design/Load Code | Recommended v Recommended Class C v
2:::::: Help Report Language: Report Language:
..... ;
=)- Output Formats English > English N
- Formats - Dim, & Others Rating Code Czech
- Formats - Forces France
. Formats - Loads Poland
@ save Changes Upon OK Default Al Set Default [I] Cancel

10/20



Civil 2023

6.1 Bk F R : EHEEZ(Gilbert and Ranzi)
- ¥7IEE Gilbert and Ranzi PiEss 2 R MR IR EL

Civil 2023 (v1.1) Release Note

- fk#& : Raymond lan Gilbert &2 Gianluca Ranzi f? 2010 FE 5t T &5 BRI BIRET A

Name

Concrete

Type
0O code (O User
Development of Strength
Code: GILBERT AND RAMZI
f{t)= fomi xex p[sx [1—(2 Bifteq)” SD

Mean in-situ compressive strength of concrete (fomi)

40 Mfmm2
Cement Type(s)

Ordinary Portland Cement :0.38 ~
Weight Density 2400 kgfjm3

Add/Modify Time Dependent Material (Comp. Strength)

i

Redraw Graph

)

Scale Factor
1.0

Graph Options
[ %-axis log scale

= Properties> Time Dependent Material > Comp. Strength > GILBERT AND RANZI

[ ¥-axis log scale

50
45
40
35
30
25
20
15
10

& 10 12 14 18

Time (day)

20 22

26

28

oK

Cancel

Development of Compressive Strength

- Modulus of elasticity
For i < 40 MPa:

E.=p'20.043/fmi (in MPa)

For 40 < f.,,; <100 MPa:
E; = p'[0.024 \/fomi +0.12] (in MPa)

- Modulus of elasticity with time

Ec(t) = (e<0-v3M) " E, 28

MibAS
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7. PSC Design: {#3E2 81 Ak #1 uk oI{ERE#TA
- HMAERGET PR EFEEAE RTEPSC-Value, PSC-Composite, General-Composite = f&ER E 482 o] DI EAEHTA -

Civil 2023 (v1.1) Release Note

Properties> Section > Section Manager > Reinforcements

| Section Manager

Mode

Reinforcements

Target Section & Element

=& Section : 3

1 T1-21500
XL 2:%uper TEnd
X 3 Super T Mid

Copy Reinforcements to...

@a a&o B

Grid: 100 i Snap

Super T End

|&: was.6, 78167 |

VIEW

X
Longitudinal Reinforcement  Shear Reinforcement |
|8 same Rebar Dats ati & j-end

1] o]

8 Sianenal Beinforcement:
Pitch 150 mm
Angle 90 [deg]
Aw 402.2 mm2

() steel Bar for Web
Fitch 0 i
Angle 90 [deq]
Ap a mrn®
Pe a M
Shear Reduction Fackor 1

B Torsional Reinforcement
Pitch 100 mm
Awt 2011 mm?
Alt 1963.6 mm2
B Endosing Stirrup
O Auto Calculation © User Input
Ak_centerline 1304467 mm2
uk_centerline 4320 mm
Ak_outside 1539582 mm2
uk_outside 5707 mm
Apply

Close

Shear Reinforcement of Section Manager

- centre-line

- outer edge of effective cross-
section, circumference u,

- cover

12/20
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8.0 LFEER D TRV ERERE 4
- FEht LRSS - SZRETEIR S IR EE Von-Mises BB LIER -

Civil 2023 (v1.1) Release Note

Main Control Data

B auto Rotational DOF Constraint for Truss/Plane Stress/Solid Elements
B tuto Mormal Rotation Constraint for Plate Elements

Tension [ Compression Truss Element (Elastic Link / Inelastic Spring)

X

= Results> Stresses > Beam Stresses (Equivalent) or Beam Stresses Diagram (Equivalent)

Mises Stresses at Ce id of Steel Beam

=] React.. Defor.. Forces Baady N N MIDAS/Civil
Mumber of Iterations/Load Case 20 = h}' s zl Tt POST-PROCESSOR
Beam Stresses{Equivalent] BEAM STRESS(EQUIV.)
Convergence Tolerance 0.001 | (Ea ) —_————
Von-Mises
Load Cases
8.429252+00
[T consider Section Stiffness Scale Factor for Stress Calculation CS: Summation v
7.66295e+00
Step Last Step hd
6.3966€e+00
Stresses 6.130362+00
Consider Reinforcement for Section Stiffness Calculation () Normal © von-Mises [ ——
B Change Local Axis of Tapered Section for Force fstress Calculation O Tau_xy () Mac-Shear 4.59777e+00
: (O Tau_xz () Princ. (maz) 3.531480400
° OF=) 3.065182+00
. Position 2.2998%9e400
Main C | Data
O1(y,42) £ i 7.662952-01
O2(3y,42) -~ ::5‘ 3 0.00000+00
o .
3 (+y,-Z s)|lo i e iy
i + it Ny
O4v,2) B, W
Y .
©5MA-Y) a 7 3 e
8 MA+) 3
O7(Aa-2)
(08 (N.A.42) STAGE:CS
C5: SUMMATION
Type of Display LEST
MEX : 60030
& contour [[Jpeform uIN - 3000
[ values B Legend FILE: 3D MODEL -
[ Animate [ undeformed UNIT: H/mm?
[:]Mirrored DRTE: 04/19/2023
VIEW-DIRECTION
Qutput Section Location X: 497
I Center J
Max All
Z: 0.602
Close

13/20
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9. GSD Excel #is5: il = HEHS
- FHEHSGHRFERIEESZESEGSD report -

2 =] %

Civil 2023 (v1.1) Release Note

Define Load Combination

= Tools> Generator > General Section Designer

P P Mz W Vz T
5| RemEmr i | e tk:lngm] (kNxm) u&'; (kN) | (kNxm)
¥ [ [icot 000 2880.00 000] o000[ 000 0.00
2icb2 1000000  1550.00 000] o000 000 0.00
3|icb3 500000 1350.00] 112000) 000 o0.00 0.00
4|icos 754000 -241500] 2640.00| 0.00| 0.00 0.00
5icbs 359000) -1450.00] 3400.00) 000 0.00 0.00

Section View : Section1

Interaction Curve | Stress Contour

PM  MyMz 3D
Mode
O angle :
Checking Ratio
Q) Keep MPP constant

0000000

Dea.

Op-my

Opz

(O Keep M constant

O Load Combinatien :

(O keep P constant

Hoop Type

Tie

Code : Eurocode2:04

Spiral

0

5
)

uy Mz
(khbcm)

18518.363|

0.000

NavaoD

13854.348|

2844.185

13259.834|

3088.594

12571.983]

3306.460

12091.494)

3500.334

11519.308|

3670.993

10856.736|

3820.881

10405547

3949.762

9865.821

4061678

9350626

4156.444

8858537

4235.074

8407673

4299.343

805,867

4343774

7645245

4321414

7113378

4271786

6522025

4185.485

4059.685

3889.404

3670.613

Mt

3399.924

3074.359

2690.837

o0

1350

1o00

260

o
000

2245.082

a0
o0

1558325

-1707.374

0.000

Report Al

Report

P-M Curve
Mode Load Combination = Icb1
Checking Ratio = 2.384 (Keep M/P Constant
sooo P Pu(kN) Mn(kNxm)
{Thata=0.300s 18618363 0.000
17750 & RZ,SDZD;% 13854 348 2844 18
15500 P-M Curve
Mode Load Combination = lcb2
11000 Checking Ratio = 0677 (Keep M/P Constant
o S Pu(kN) Mn(kNxm}) -1
Thefazo.g00 6. 18618.363 0.000
8500 17760 P e 13854.348 2844.186
250 vs2ho 13259834 3088.594
iayhaloha TREFT 65 S3RE AR
2000 13250 P-M Curve
B 110p0 Mode Load Combination = Icb3
2500fgtenben b s 3750 Checking Ratio = 1.198 (Keep M/P Constant)
2 2 8 £ § aha 20000 F0EN) - Pu(kN) Min(kNxm)
L tams gene 18618 363 0.000
4250 7750 R Raiin s 15710483 1047858
1500 et 14919 966 1155.320
2ape 14103774 1532567
£ Tegee 13293.674 1314.875
| 11000 41940C O9E 4204 £NC
L =T P-M Curve
2 8 8 750
s200 Mode Load Combination = lIcb4
Checking Ratio = 3.386 (Keep M/P Constant,
4250 20000 2 4KN} i Pu(kN) Mn(kNxm)
pyon R iy 18618.363 0.000
i Rt 80 15473694 978839
1 i 15500 14670.065 1069.599
2500 13888355 1148447
88 13750 TR ATT 558 AGE
Ll P-M Curve
11000}
sTDU [ Mode Load Combination = Icb8
P BB Checking Ratio = 6.686 (Keep M/P Constant
20000 [2 1) - Pu(kN) Mn(kNxm)
4250 (== NALS3 4204 18618.363 0.000
2o00| e REiHE 10 14827 449 841783
15500 14056 620 5357683
13379.895 1019.282
12682.163 1086.550
11000 11979889 1145635
e 112887743 11547257
i } 10613.982 1232.493
o500 9967.001 1263.977
o 9331 757 1284.925
{2550, 2008) 8738 584 1258148
2000 8175284 1305.567
0. 784) M (kN 7738.030 1308.730
: 7196163 1295125
2500 6466552 1270877
= = ™ Y
¢ B 8 B 8|9 B § § 8 5658242 1235.319
4791.853 1187.060
3908743 1107.766
2583810 1013575
2006.083 915.062
1018.217 766.886
-16.058 634672
“BEG B2 465838
-1564 498 89 669
1707374 0.000
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Civil 2023 (v1.1) Release Note

= Properties> Material > Concrete > TMH7

Concrete Material

Material Data X || Modify Concrete Materials *
General Material List
— 2 Grade %0
; Sejenal D Lo i D Name flftkR  Chk  Lambda Masinber  Sub-bar
Elasticity Data 1 Grade 40 40 X 1
Type of Design Concrete v S
Standard
08
Concrete Material Selection
Code : TMH7(RC) w Grade:  Grade 40 ~
Type of Material i 3
fied Compressive Strength (Fcfck ) Njmm?
© 1sotropic Orthotropic iy (1
Light Weight Concrete Facter (Lambda) ; -
Steel Rebar Selection
Modulus of Elasticity : 0.0000e +00 1
e = Code : TMH7RC) ot
Grade of Main Rebar : 450 Njmm3
Thermal Coefficent : 0.0000e +00
Grade of Sub-Rebar : 450 Njmm2
Weight Density 0
Use Mass Density: 0 Nfmm3fg Madify Clase
Modulus of Blasticity : 310006404 Njom2 Reinforcement Material
Poisson’s Ratio 0.2
Thermal Coefficent : 1200005 y/7c]
Weight Density 23205 Nfmm>
() Use Mass Density: 2.345¢-09 g
Nl Rebar Material Property
Plasticity Data
Plastic Material Name  NONE v Rebar Material Code TMHT{RC)
Inelastic Material Properties for Fiber Model Rebar Grade Type C
Concrete  None v Rebar  None v
450
= Rebar fy Mfmm2
Specific Heat 0 BuN-[C] Modulus of Elasticity 200000 Mjmm?
0 T . . .
Heat Conduction Btu/mm e[C] Stress Strain Curve Park Strain Hardening w
Damping Ratio 0.05
o) coe sovl Cloge

Reinforcement Material

Material Data

General
Material ID 2 Name Grade 40
Elastiaty Data
SRS Steel
ype of Desian  RC v 2 4
D8
Concrete
Type of Material
© 1sotropic Orthotropic
Steel
Strenath s 0
Modulus of ElastiGity : 0.0000e+00
Poisson's Ratio  : 0
Thermal Coeffident : 0.0000e+00 /M) Nonlinear
Weicht Density 0 Nfmm? Properties
Use Mass Density: 0 Njmm3la
Concrete
Strength 3 40 Nfmm2
Modulss of Elastiaty : 3.1000e+04 Njmm? 8 Use Nonlinear
Poisson's Ratio s 0.2 oeie
hermal Coefficent : 1.2000e-05 ym =
2.3205
Weight Density 3e Nfmm? Pt
(O Use Mass Density: 2345209 Njmmdfa

(o ] oo Aosly

Concrete Material
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Civil 2023 (v1.1) Release Note

E,_DBRIE@@

View Structure Node/Element Properties
(O)staticloads  |(@) DynamicLoads| (T Settlement/Misc.

O Temp./Prestress O Construction Stage O Load Tables
(") Moving Load (") Heat of Hydration

| Time History Analysis Data |
Time History Concurrent Result G-~
Group Name G1
Mater Node 72
Sub Nodes 7073
Type of Result
Opisp.  Ovel. O Accel.
Component DX i
MName Master Node Type
61 72 Diispl.
G2 1 Displ.
Operations
Add Modify Delete
Close

Define Node Groups

Functions Cases

= Results> Result Tables > Time History Analysis > Displ./Vel./Accel. (Concurrent)

Boundary Results PsC Pushover

BB

RS RS Load Global Load Time History Ground
Control = Cases

Analysis Design

2=

Dynamic
Functions Acceleration Nodal Loads Static Loads

Rating Query

Excitation

» [oad> Load Type > Dynamic Loads > Time History Analysis Data > Define Concurrent Result Groups

Civil 2023 - [Untitled] - [MIDAS/Civil]

Tools

kR kB B @

Time Varying Multiple Support Define Resulf Define Concurrent
Result Groups

Functions

L
v,

fTrain Load
enerator

Hrmax
ST
f Reaction i b ,
1'1? Concurrent(MaxMin) Reaction .-“\ Q
2 concurrentiMayMin) Joint Force v /
_!_ Displacements |
Truss »
Cable »
Beam *
Plate 13
Plane Stress »
Plane Strain »
Axisymmetric » &max=6rmax-(6fp+8fp~h+8s) Smax=5rmax-(6fp+efp=h)
Solid L
':’ Elastic Link
': General Link
Bx Resuttant Forces e — o (r[r)l:l) tﬁ) tsrzn) (tsaxdn ([f:m ([fm}
L vibration Mode Shape Mater Node(72)]  97.009600 0.000547 -0.205912 -0.000000 0.001684 -0.000033
* Buckling Mode Shape EX(max) Sub Node(70) 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
BB e cive Span Lengin Sub Node(73) 24.129700 -0.000193 -0.077511 0.000001 0.001782 -0.000050
Mater Node(72)]  -77.893400 -0.003365 0.440000 0.000013 -0.001365 0.000019
= G1 EX(min) Sub Node(70) 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
Inelastic Hinge » Sub Node(73) -23.230400 0.000922 0.170059 -0.000003 -0.001508 0.000049
| Time History Analysis | » R oispuveraccer Mater Node(1) | 131.728000 -0.012116 -0.319860 0.000002 0.000950 -0.000054
Heat of Hydration Analysis W[k8 DispinevacceiiConcurrenty o X Sub Node(70) 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
ey »[FI Beam Force Sub Node(72) 96.609000 0.000783 -0.228289 -0.000001 0.001692 -0.000032
Sub Node(73) 24106900 -0.000252 -0.086362 0.000001 0.001773 -0.000049
(R IR hTiE B Mater Node(1) | -112.312000]  -1.110280 0.590966 0.000043|  -0.001041 0.000030
e e ) o o ) Sub Node(70) 0.000000 0.000000 0.000000 0.000000 0.000000 0.000000
B Equilibrium Element Nodal Force < 2R Sub Node(72) -T7.818700 -0.003272 0432113 0.000013 -0.001381 0.000019
S8 initial Element Force Sub Node(73) -22.805700 0.000893 0.167061 -0.000003 -0.001495 0.000046
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= PSC > Design Parameter> AASHTO LRFD

A/B/CDEFGHI JKLMNOPQRS T UV WX Y, ZAAABACADAEAFAG

141)
142
143
144
145
146
147,
148
149
150
151
152
153
154,
199|
200
201
202
203
204
205
206

2 Flexure design for a section

W Moment Direction Positive
- Method of Calculation : Code
- The maximum strength limit load combination : cLCB3
- The maximum factored moment (M) : 6832.570 (kips-in)
1) Depth of neutral axis to compression face (See 5.6.3.1)
5 Axial force in tendons(Bond) by Code
Tendon Name 3 o TP Af=(dc)
1 5_Spani-263 0.374 44,509 9.658 541.010
2 5_Spani-253 0.374 44510 9.659 541.027
3 5_Spani-243 0.374 44204
4 & Bpani2aa 074 a3sa9 ] Tendon stress at ULS within development length
No. Deselegp e Lencth |
Tendon name 1, (in) Iy(in) e (iN) T (ksi)
1 5_Spani-263 31.50 152.65 15.75 44 51
2 5_Spani-253 31.50 152.65 15.75 44 51
3 5_Spani-243 31.50 153.15
i & Epaniays ITER is5gs " Transfer Length & Development Length

207|

m

S I
ﬁﬂWIIHﬂIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII

*The section is located within the transfer length

Development Length in Report

T T
IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIh‘HIIHth;A

100 011000

Flexural Resistance Diagram

Strand
Siress

opu

op.ef]

Tranmissiﬂn(L%t)
Developement Length (Lp)

i
At nominal resistance of member

L =60db

Ly = 0.145( 6u—0.67 G oe)dly = 604y,

N

Lpt

Lp

Stresses in the Tendon at ULS

A1

A

111100

MIDAS/Civil

BOST-FROCESSOR

P5SC DESIGH

Flexure-y

2008.
1326.
leds.
14g0.
1278.
1085.
G913.
730.
547.
385.
152.

PostCs 1)
ALL COMBINATICH

[ A T T R R =]

MibAS
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Civil 2023 (v1.1) Release Note

= PSC> Design Parameter > CSP 35.13330.2011

P5C Design Parameters

Design Code : SP 35.13330.2011 e
Input Parameter
Bridge Type Roadway /Pedestrian ~

8 operation Condition Factor (mb7, mbs)
© Ambient temperature for the coldest five days below -40C without concrete saturation
O Ambient temperature for the coldest five days -40C and higher with concrete saturation
O Ambient temperature for the coldest five days below -40C with concrete saturation
() User Defined 0.9 0.9

8 Operation Condition Factor (mbs)
© Not protected solar radiation in Climatic Zone IV A

() User Defined 0.85
Qutput Parameter
First Group Limiting States {ULS) Second Group Limiting States (SLS)
8 Ultimate Bending Resistance B stress for Cross Section at a Construction Stage

B Stress for Cross Section at Service Loads
B Principal Stress at a Construction Stage

8 shear Resistance

8 Torsion Resistance

B Faticue B Principal Stress at Service Loads
B Tensie Stress for Prestressing Steel
8 Erack Controf

PSC Design Parameters

Cancel

Material (GOST-SP) Crack Opening Coefficient, W
A600 1,5sqrt(Rr)
A800 1,5sqrt(Rr)
AT600 1,5sqgrt(Rr)
AT800 1,5sqgrt(Rr)
AT1000 1,5sqrt(Rr)
V1500 0,35(Rr)
V1400 0,35(Rr)
V1400 (Group S) 0,35(Rr)
V1400 (Group Zh) 0,35(Rr)
V1300 0,35(Rr)
V1200 0,35(Rr)
Vp1500 1,5sqrt(Rr)
Vp1400 1,5sqgrt(Rr)
Vp1200 1,5sqgrt(Rr)
K7-1500 1,5sqrt(Rr)
K7-1400 1,5sqgrt(Rr)

Crack Opening Coefficients

MibAS
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14.1#kK&7 (Concurrent Force)
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= Load> Moving Load Analysis Data > Concurrent Joint Force Group

= Results> Result Tables > Concurrent (Max/Min) Joint Force

Maoving Load Code —_— LC /&7 Plate Element for Influ, Surface "l..ﬂ Railway Dynamic Factor
EUROCODE M = E %+ Concurrent Reaction Group

Traffic Line | Traffic Surface Vehicles Moving

Lanes * Load Case %Concurrent]oint Force Group

Moving Load Analysis Lata

/R
|

W.
A
=
%

P
[’//’/'\

.
|
/ 4
A
W
A

il
,/‘
i
!

= |

[
{
A

d
f
l_\

N

Tree Menu

Tables Works Report

Group
=- ﬂ Structure Group : 2

Cross Beam 1[ Mode=0 ; Bement=22]
T = = o Conmection [ Node=1 ; Element=0
Elem. Load Fx Fy Fz Wx Wy Wz Fx Fy Fz W onnection [ Node=1: Elem 1
= Erozma () ) (i) (tt-m) (tt-m) (tt-m) (ki (i) (ki) (kti-m) e Boundary Group : 0
11111 |Node:d Apply 4, Load Group : 0
Results Fx 0.0 0.0 00 00 0 00 [X) 00 00 0.0 s Tendon Group : 0
Tables = Fy 5967 103 24 83 ETF] 572 538.0 148 23 378
i Fz 10118 7 2585 51 800 97 9131 54 218 o3
Ll poadion RIGEY i 7870 58 55 164 710 709 8473 74 140 214 s5.0|
t iy 12625 74 78 78 2977 618 11192 54 ) KL
. . [ -1282.0 113 136 124 2117 93| 11305 128 261 21j i
Iﬁ Concurrent(Max/Min) Reaction Fx 0.0 0.0 00 00 00 00 0.0 00 ) 0.8 Select Nodes and Assign Structure Group
Fy 1437 X 131 114 1492 930 10171 130 194 232 1613
% Concurrent{Max/Min} Jaint Force p e Fz 10648 77 148 91 2772 646 9368 [ 386 160 2856
u Rl X 7878 96 09 107 EEX] 516 7135 138 51 402 302
Displacements My 12518 a3 178 79 2974 809 11085 82 342 121 303.1
Mz 11016 2 134 121 1509 938 773 130 203 243 1840
Fx 19674 51 221 50 2142 511 A76id 64 213 o3 2141
Fy 11864 74 136 75 2192 618 10618 86 258 138 2295
. D Fz S8z 539 92 159 7.0 57.4 711 53 i 211 57.0
Mix 12465 EIN 133 137 2130 27|  -10%2 123 259 28 2229
iy E 35 56 64 720 X 449 73 141 214 571
iz 00 00 00 00 00 00 00 00 00 00 00
Fx 10182 15 -18 64 20 -138 810 X =3 88 51
Fy 14615 107 187 129 2007 g9.1|  -1290.5 18 29 182 2085
Fz 5701 73 92 6.0 %3 610 5652 60 119 218 557
Ll R i 5446 =3 104 129 370 %3 5432 23 58 64 583
My 8880 T4 93 16.0 2 1.1 s83.4 80 19 219 555
Mz -1299.0 110 135 137 2110 21| 11430 12,1 250 22 2209
Fx 00 00 o0 00 00 ) 00 o0 o0 00 o0
Fy ELiZE) EX] 185 65 7773 €25 13155 85 %65 78 2778
Fz 14200 75 187 77 2914 629| 12813 84 313 104 2059
=L iRETY Mix S0z 45 30 114 920 B8 S096 24 18 X 21
iy 00 00 00 00 00 00 00 00 00 00 00
iz 00 00 00 00 00 00 00 00 00 00 00

Concurrent Forces of Members Connected at Joints
MiIDAS 19/20
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ERTEBIMEN BRI ENE
- Revit 2023
- Tekla 2022

BERBEEHESNT - VB2 - RS EHSHNHEEIFRETRS
- EC2 Concrete Design
- EC3 Steel Design

ETEESEHTENHER ST - ol IR Humbly equation SLAE1E A -
- ‘A)#E: F3 Humbly Equation 5t & beam-and-slab decks IR & 21 - T EEE R RAAHE -
- ADENABEENRBETEHRERE -

Properties>Section>Composite

[ Ju=e Humbly Eq. for Txx

MibAS
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